KOSSEL MINI BUILD GUIDE

BY BLOMKER INDUSTRIES
a minimalist yet revolutionary delta robot 3d printer designed by Johann Rocholl [reprap.org/wiki/Kossel]

#Kossel Mini

This Build Guide

aim to provide easy to follow step-by-step instructions on assembly and calibration of Kossel Mini kit supplied by Blomker Industries [blomker.com]
Let’s Begin

Prepare Assembly Jig for Push Rods assembly

Note: Please complete Part {A} and Part {B} before starting frame assembly. Some of the needed materials for Part {A} and Part {B} are the same materials for frame assembly.
Parts required for Push Rod Assembly Jig as shown above

- OpenBeam 240mm = 1 pc
- M3 x 8mm Cap Screw = 2 pcs
- M3 Nut = 2 pcs
Insert M3 Nut into OpenBeam slot guide and fasten it with M3x8mm Cap Screw. Repeat the same at the other end of OpenBeam.
Repeat steps {A01} to {A02}. Total 6 sets of Push Rod Assembly Jigs needed as shown above.
Let’s Push Forward

Assemble the Push Rods

Note: Push Rods assembly quality has direct impact on the final build quality of Kossel Mini. Advisable to go thru and understands all the steps in Part {B} before proceed further.
Parts required for Push Rod Rod End assembly

- Traxxas Ball Joint = 1pc
- Traxxas Rod End = 1pc
- M4 x 20mm Set Screw = 1pc
Prepare Parts

Tap the Traxxas Rod End with M4 Tap Drill
Push the ball joint into the Traxxas Rod End ball joint holder.
Screw the M4x20mm set screw into the tapped Rod End.
!!!Make sure set screw is aligned to the center axis of Rod End
Repeat steps {B01} to {B03}. Total 12 sets of Push Rod Rod Ends assembly needed as shown above.
Prepare Parts

Parts required for Push Rods full assembly

- 180mm Carbon Fiber Rod = 6 pcs
- Assembled Rod End = 12 sets
Apply slow-setting epoxy glue on the set screw of Rod End
Slowly join the Carbon Fiber Rod and Rod End. Excess epoxy will be dissipated at the wet joint area. Swiftly repeat steps \{B06\} to \{B07\} for the other end of the Push Rod
Lay the assembled Push Rod on the Assembly Jig prepared in Part {A}. !!! Align the flat side of both Rod Ends perpendicularly to the OpenBeam slot guide. Also, make sure the center axis of all these parts aligned perfectly to each others.
Push the Rod End against the tightened M3x8mm cap screw and make sure the wet joint is firmly intact.
At the other end of Push Rod, push the M3x8mm cap screw against the Rod End and tighten it. This locking mechanism is to make sure the wet joints are firmly intact while waiting for the glue to dry.
Repeat steps {B06} to {B10} for the remaining 5 sets of Push Rods.
The most important aspect of Push Rod assembly is to have all of them assembled and aligned to the same length, end-to-end. A simple verification method as shown above can help to isolate the odd one out and readjust the wet joints before they are fully dried.
Once the glue dried up over night and solid bond has formed, remove the assembled Push Rods from the Assembly Jigs. You should expect the same end-to-end length for all the Push Rods.
Let’s Frame It Up

Assemble the Main Body Frame

Note: Advisable to complete all the assembly related to the Vertical Frames before attaching the Top Frame
Bottom Vertex = 1 pc

M3 x 8mm Cap Screw = 10 pcs

M3 Nut = 10 pcs

Parts required for a single Bottom Vertex assembly
Attach all 10 pcs of M3x8mm Cap Screws and M3 Nuts to the Bottom Vertex as shown above.
Repeat steps \{C01\} to \{C02\}. Total 3 sets of assembled Bottom Vetexes needed as shown above.
[Prepare Parts]

Parts required for Bottom Frame Vertex assembly

- Assembled Bottom Vertex = 1 set
- OpenBeam 240mm = 2 pcs
Align the M3 Nuts at one side of the Bottom Vertex assembly to the opening of OpenBeam slot guide and slot them in all the way to the end.
Fasten both OpenBeams which are in correct position by tightening the M3 Cap Screws as shown above.
Repeat steps {C04} to {C06}. Total 3 sets of assembled Bottom Frame Vertexes needed as shown above.
Prepared Parts

Parts required for Bottom Frame assembly

Assembled Bottom Frame Vertex = 3 sets
Align the M3 Nuts at the opened side of the assembled Bottom Frame Vertexes to the opening of OpenBeam slot guide and slot them in all the way to the end.
Tighten the Screws

Fasten the newly slotted in OpenBeams which are in correct position by tightening the M3 Cap Screws as shown above.

[Tools]
M3 Allen Key
[Inspection]

Place the completed Bottom Frame on flat surface and make sure the bottom part is perfectly even.
[Prepare Parts]

Parts required for Top Vertex assembly

- Top Vertex = 1 pc
- M3 x 8mm Cap Screw = 5 pcs
- M3 Nut = 5 pcs
Attach all 5 pcs of M3x8mm Cap Screws and M3 Nuts to the Top Vertex as shown above.
Parts required for Top Vertex Belt Idler assembly. Layout in proper assembly arrangement.
Attach M3 Nut, M3 Washers and Flanged Bearings as arranged in \{C14\} and fasten them to the assembled Top Vertex by tightening the M3x25mm Cap Screw as shown above.

[Tools]
M3 Allen Key
Repeat steps {C12} to {C15}. Total 3 sets of assembled Top Vertexes with Belt Idlers needed as shown above.
[Prepare Parts]

Parts required for Top Frame Vertex assembly.

- OpenBeam 240mm = 1 pc
- Assembled Top Vertex with Belt Idler = 1 set
Align and Slot In

Align the M3 Nuts at one side of the assembled Top Vertex to the opening of OpenBeam slot guide and slot them in all the way to the end.
Fasten both OpenBeams which are in correct position by tightening the M3 Cap Screws as shown above.
Repeat steps {C17} to {C19}. Total 3 sets of assembled Top Frame Vertexes needed as shown above.
[Prepare Parts]

Parts required for Top Frame assembly

Assembled Top Frame Vertex = 3 sets
Align and Slot In

Align the M3 Nuts at the opened side of the assembled Top Frame Vertexes to the opening of OpenBeam slot guide and slot them in all the way to the end.
Fasten the newly slotted in OpenBeams which are in correct position by tightening the M3 Cap Screws as shown above.
[Inspection]

Place the completed Top Frame on top of the Bottom Frame and make sure they are perfectly aligned at the vertex points and as well as the edges.
Prepare Parts

Assembled Bottom Frame = 1 pc

OpenBeam 600mm = 3 pcs

Parts required for Vertical Frame assembly
Align the OpenBeam Vertical Frame slot guide to the M3 Nuts inside one of the assembled Bottom Frame Vertex’s vertical frame opening and slot it in all the way to the end.
Once the OpenBeam Vertical Frame fully slotted in, secure it by tightening the M3 Cap Screws as shown above.
Repeat steps {C26} to {C27}. Total 3 Vertical Frames assembly needed as shown above.
Prepare Parts

Parts required for Endstop assembly

- Endstop = 1 pc
- M3 x 8mm Cap Screw = 1 pcs
- M3 Nut = 1 pcs
Attach M3x8mm Cap Screws and M3 Nuts to the Endstop as shown above.
Repeat steps {C29} to {C30}. Total 6 sets of Endstops assembly needed as shown above.

[Tools]
M3 Allen Key
Slot in 3pcs of Endstops assembly with flat side facing up as shown above. Temporarily fasten the Endstops assembly to the Vertical Frame. To be fully tightened after Linear Rail attachment completed.
Prepare Parts

Parts required for Linear Rail assembly

- Linear Rail 400mm = 1 pc
- M3 x 8mm Cap Screw = 16 pcs
- M3 Nut = 16 pcs
Attach all 16pcs of M3x8mm Cap Screws and 16pcs of M3 Nuts thru the Linear Rail mounting holes as shown above.
Repeat steps \{C33\} to \{C34\}. Total 3 sets of Linear Rail assembly needed as shown above.
Parts required for Linear Rail to Vertical Frame assembly

Assembled Bottom and Vertical Frame = 1 set

Assembled Linear Rail 400mm = 3 sets
Slot in the assembled 400mm Linear Rail set to the Vertical Frame as shown above. The suggested positioning is based on the dimensions of moving parts supplied as well as required linear motion space at lower end, eg. During auto bed leveling etc.
[Tighten the Screws]

!!!Once making sure that all 3 sets of Linear Rail having the same positioning on the Vertical Frame, secure them by tightening all 48 pcs of M3x20mm Cap Screws.
Further secure the Linear Rails on the Vertical Frame by pushing the lower Endstops up against them and tightening of the M3x8mm Cap Screws.
Prepare Parts

Parts required for Upper Endstops attachment to Vertical Frame

Assembled Bottom and Vertical Frame with Linear Rails Attached = 1 set

Assembled Endstops = 3 sets
Slot in the upper Endstops with flat side facing down and push them down against the Linear Rail. Tighten the M3x8mm Cap Screws.
[Prepare Parts]

Parts required for Extruder Motor Holder assembly

- Extruder Motor Holder = 1 pc
- M3 x 8mm Cap Screw = 2 pcs
- M3 Nut = 2 pcs
Attach all 2pcs of M3x8mm Cap Screws and 2pcs of M3 Nuts thru the Extruder Motor Holder mounting holes as shown above.
Assembled Bottom and Vertical Frame with Linear Rails Attached = 1 set

Assembled Extruder Motor Holder = 1 set

Parts required for Extruder Motor Holder attachment to Vertical Frame assembly
Slot in the assembled Extruder Motor Holder set into one of the Vertical Frame as shown above. Position it at the mid-point of the Vertical Frame. Tighten the M3x8mm Cap Screws.
Prepare Parts

Parts required for Vertical Carriage assembly

- Vertical Carriage = 1 pc
- M3 x 8mm Cap Screw = 2 pcs
- M3 x 16mm Cap Screw = 2 pcs
Insert 2pcs of M3x16mm Cap Screws into upper screw holes and 2pcs of M3x8mm Cap Screws into lower screw holes as shown above.
Repeat steps {C46} to {C47}. Total 3 sets of Vertical Carriage assembly needed as shown above.
Attach the assembled Vertical Carriage set onto the Linear Guide Carriage and tighten all the Cap Screws as shown above.
Repeat steps {C49}. Total 3 sets of Vertical Carriages assembly needed as shown above.
Prepare Parts

Parts required for Vertical Carriage assembly

M3 Nylon Lock Nuts
= 6 pcs
Slot in 2pcs of Nylon Lock Nuts into Vertical Carriage as shown above. Repeat the same for remaining Vertical Carriages.
Assembled Bottom and Vertical Frame with Linear Rails Attached = 1 set

Assembled Top Frame = 1 set

Parts required for Top Frame to Vertical Frame assembly

[Prepare Parts]
Slot in the assembled Top Frame and position it 15mm below the Top of Vertical Frame at each vertex as shown above. Gently tighten the M3x8mm Cap Screws at each vertex once the Top Frame is in position.
[Prepare Parts]

Parts required for Belt Tensioner assembly

- M3 Nut = 1 pc
- M3x35mm Cap Screw = 1 pc
- M3 Washer = 1 pc
Slot in the assembled Belt Tensioner Screw as shown above.
Attach M3 Nut to the Belt Tensioner Screw as shown above.
Gently tighten the Belt Tensioner Screw till the M3 Nut is in position shown above. Avoid over tightening as this will cause elevation of the corresponding Top Frame Vertex which is unnecessary at this point of time.
Repeat Steps \{C55\} to \{C58\} for the remaining 2 vertexes.
Let’s Move It
Assemble the Moving Parts
NEMA17 Stepper Motor = 1 pc

GT2 Aluminium 16 Teeth Pulley = 1 pc

Set Screw = 2 pcs

Parts required for Stepper Motor Assembly
Attach the GT2 Pulley to the Stepper Motor shaft and tighten the Set Screw as shown above.
Repeat Steps \{D01\} to \{D02\}. Total 3 sets of Stepper Motor assembly needed as shown above.
Parts required for Vertical Linear Motion Stepper Motor mounting to the assembled Main Body Frame

- Assembled Main Body Frame = 1 set
- Assembled Stepper Motor = 3 sets
- M3x8mm Cap Screw = 12 pcs
Mount the assembled Stepper Motor to the Bottom Vertex and tighten the M3x8mm Cap Screws (4pcs) as shown above.
Repeat Steps {D05}. Total 3 sets of Vertical Linear Motion Stepper Motors needed as shown above.
Parts required for Vertical Linear Motion Drive Belt assembly. 
Note: 4000mm Open Ended GT2 Belt supplied in the kit. Cut it into 3 pcs.
Position the Vertical Carriage at the top end of Linear Rail and guide one end of the open ended GT2 belt into Vertical Carriage belt clamp as shown above.
Cable tie the open end of the GT2 Belt as shown above. Also, make sure the Nylon Lock Nuts in the Vertical Carriage nut traps stays intact.
Loop the GT2 Belt over the Belt Idler’s Flanged Bearing, and pull it downwards. Then loop it over the GT2 Pulley and pull it upward as shown above. The Vertical Carriage should stay anchored during pulling actions.
Pull the GT2 Belt tight and guide it into the lower belt clamp of the Vertical Carriage as shown above.
Assemble

Fasten the opened end of the GT2 Belt with cable tie as shown above. Trim off excess length of GT2 Belt at both ends. Suggest to reserve around 40mm of excess GT2 Belt length at lower end of Vertical Carriage. Secure it with cable tie. This is just in case future modifications needed.
Repeat Steps {D07} to {D12}. Total 3 sets of Vertical Linear Motion Drive Belts assembly needed as shown above. Upon completion, lubricate the Linear Rail to ensure smooth operation during printing.
Gently tighten the M3x8mm Cap Screws at each Top Vertex. In case GT2 Belt tension not ideal, tighten the Belt Tensioner Cap Screw for better Belt Tension.
[Prepare Parts]

Parts required for Effector assembly

- Effector = 1 pc
- M3 Nylon Lock Nuts = 6 pcs
[Assemble]
Thread the M3x25mm Cap Screw thru the ball joint mounting hole and attach an M3 Nylon Lock Nut as shown above.
Pull the M3x25mm Cap Screw as shown above to fit the M3 Nylon Lock Nut into the Effector’s Nut Trap.
Repeat Steps {D16} to {D17}. The completed Effector assembly is as shown above.
[Prepare Parts]

Parts required for Effector & Push Fit Connector assembly

Assembled Effector = 1 set

Push Fit Connector = 1 pc
Tap the Effector’s Push Fit connector mounting hole with M5 Tap Drill.
[Assemble]

Mount the Push Fit Connector to the Effector assembly
Prepare Parts

Parts required for Effector & Push Rod assembly

Assembled Effector = 1 set
M3x25mm Cap Screw = 1 pc
Assembled Push Rod = 1 set
Assembled Effector = 1 set
Thread the M3x25mm Cap Screw into the Push Rod Ball Joint as shown above
Attach the Push Rod to Effector assembly and tighten the M3x25mm Cap Screw as shown above.
Repeat Steps {D22} to {D24}. The completed assembly should have all 6 sets of Push Rods attached to the Effector as shown above.
Prepare Parts

M3x20mm Cap Screw
= 6 pcs

Parts required for Push Rod to Vertical Carriage assembly
Attach the Push Rod Ball Joint to the Vertical Carriage’s ball joint mount and tighten the M3x20mm Cap Screw as shown above.
Repeat Steps \{D27\} to attach remaining Push Rods to the rest of Vertical Carriages as shown above.
Parts required for Extruder Motor Drive Gear assembly

- NEMA17 Stepper Motor = 1 pc
- Extruder Drive Gear = 1 pc
Attach the Drive Gear to the Stepper Motor shaft and tighten the Set Screw as shown above.
Prepare Parts

Extruder Motor Adaptor = 1 pc

625ZZ Bearing = 1 pc

M5 Nut = 1 pc

M5x20mm Cap Screw = 1 pc

Parts required for Extruder Motor Adaptor assembly
Insert the M5 Nut into the nut trap as shown above.
Insert the 625ZZ Bearing into the bearing mount and secure it with M5x20mm Cap Screw as shown above. In case the 625ZZ Bearing not able to rotate freely, reattempt this step after remove remaining support material from bearing mount.
Assembled Extruder Motor = 1 set
Assembled Extruder Motor Adaptor = 1 set
M3x8mm Cap Screw = 3 pcs

Parts required for Extruder Motor Adaptor Mount assembly
Mount the Assembled Extruder Adaptor to the Stepper Motor and secure it with M3x8mm Cap Screws as shown above.
Assembled Extruder Motor = 1 set

M3 Nut = 1 pc

M3x20mm Cap Screw = 1 pc

[Prepare Parts]

Parts required for Extruder Motor Adaptor Clamp assembly
Insert M3 Nut into nut trap and thread the M3x20mm Cap Screw thru the clamp holes as shown above. Do not over tighten the M3x20mm Cap Screw at this stage.
[Prepare Parts]

Parts required for Extruder Motor Adaptor Clamp assembly

Assembled Extruder Motor = 1 set

Push Fit Connector = 1 pc
[Assemble]

Tap the Push Fit Connector mounting hole with M5 Tap Drill as shown above. Only tap the required depth needed to mount the Push Fit Connector.
Mount the Push Fit Connector as shown above.
Mount the Assembled Extruder Motor to the holder prepared in Step {C45}. Secure it with 4 pcs of cable ties as shown above.
Final Extruder Motor mounting to the Main Body Frame is as shown above.
[Prepare Parts]

Bowden Extruder PTFE Tube 550mm = 1 run

Part required for Bowden Extruder assembly as shown above
Insert both ends of the PTFE Tube into respective Push Fit Connectors as shown above.
The Bowden Extruder design above aim to maintain the tube end in vertical position during different print heights, hence ensure smoother downward push of filament into the Hot End during prints.
Parts required for Hot End assembly

1. 1.75mm Hot End Assembly = 1 pc
2. Aluminum Groove Mount = 1 pc
Slot the Hot End Groove Mount into the groove of Hot End assembly as shown above.
[Prepare Parts]

Parts required for Fan Holder assembly

- 30mm Fan = 1 pc
- Paper Clip = 2 pcs
Unwind the Paper Clip as shown above
Repeat Step \{D49\}. 2 pcs of unwinded Paper Clips needed as shown above. Illustration of ruler is to indicate the size of Paper Clips used.
Thread the unwinded Paper Clips to the 30mm Fan screw holes as shown above.
Using Long Nose Pliers, apply bending and compressing forces to secure Fan as shown above.
Assembled Fan Holder is as shown above.
Parts required for Full Effector assembly.

- Assembled Hot End = 1 set
- Assembled Fan Holder = 1 set
- Auto Level Probe Holder = 1 pc
- M3x20mm Cap Screw = 2 pcs
- M3x16mm Cap Screw = 2 pcs
- M3 Nut = 4 pcs
From here onwards, this Build Guide will follow the above arrangements for X-Y-Z Towers. In essence, X-Y-Z Towers are in counter-clockwise arrangements, and the one with Extruder Motor will be the Z-Tower.
Orientate the Assembled Hot End below the Effector as shown above. Z-Tower is the reference for the above orientation.
Mount the Assembled Hot End into the Effector’s Hot End mount as shown above. Align the screw holes of the Groove Mount to Effector’s screw holes.
Assemble

Mount the Auto Level Probe Holder and thread 2 pcs of M3x20mm Cap Screws thru the screw holes, and another 2 pcs of M3x16mm Cap Screws thru the Effector screw holes as shown above.

[Tools]
M3 Allen Key

M3x20mm Cap Screw = 2 pcs
M3x16mm Cap Screw = 2 pcs
Temporarily secure the Hot End assembly in position using 4 pcs of M3 Nuts as shown above.
Orientate the Assembled Fan Holder below the Effector as shown above. Z-Tower is the reference for the above orientation.
Slide the Fan Holder in between the Groove Mount and Effector. Once in position as shown above, align the Hot End heat block and Fan parallel to the X-Y Edge shown in Step {D55}. Tighten all the Cap Screws and Nuts and make sure the Hot End assembly and Fan mount are firmly secured.
Orientate the Fan such that air flows are directed towards the heat sink barrel and the Aluminum Groove Mount only as shown above. Air flow towards the Heat Block should be avoided and a safe gap between the Fan and heat block should be maintained.
Final Fan mount should be centered as shown above.
[Prepare Parts]

Parts required for Endstop Microswitch assembly.

Endstop Wires = 3 pairs

Endstop Microswitch = 3 pcs
Mark the same wire housed in socket with Pointer symbol, using eg. Marker Pen as shown above.
Solder the marked wire to the “C” (or “COM”) terminal and the other wire to the “NC” (or “Normally Closed”) terminal as shown above.
Repeat Steps {D65} to {D66}. 3 sets of Endstop Microswitch assembly needed as shown above.
[Prepare Parts]

Parts required for Endstop Microswitch Mounting.

Assembled Endstop Microswitch = 3 sets

M2.5x12mm = 6 pcs
Fasten the Assembled Endstop Microswitch to the Upper Endstop Holder by tightening the 2 pcs of M2.5x12mm Cap Screws as shown above.
Repeat Step {D69} for remaining Endstop Microswitches as shown above. Make sure Vertical Carriage for all Towers have good contact with the respective Microswitch Lever upon hitting the Endstop.
[Prepare Parts]

Parts required for Auto Level Probe Microswitch assembly.

- Endstop Wires = 1 pair
- Endstop Microswitch = 1 pc
Solder the marked wire to the “C” (or “COM””) terminal and the other wire to the “NO” (or “Normally Opened”) terminal as shown above.
Bend the Microswitch terminals using Long Nose Pliers as shown above. Trim the Microswitch metal lever to 7mm using Metal Cutter as shown above.
Mount the prepared Auto Level Probe Microswitch to the Auto Level Probe Holder and tighten the M2.5x12mm Cap Screws as shown above.
Parts required for Auto Level Probe Docking Latch assembly.

M2.5x12mm Cap Screw = 1 pc

Safety Needle 2.5mm Diameter = 1 pc

[Tools]
Long Nose Pliers & Metal Cutter
Mount the Auto Level Probe Docking Latch assembly to the Auto Level Probe Holder as shown above. Gently tighten the M2.5x12mm Cap Screw just enough to hold the modified Safety Pin in position.
[Prepare Parts]

Parts required for Auto Level Probe assembly.

1.5mm Allen Key = 1 pc
23.5mm Compression Spring = 1 pc
Terminal Block = 1 pc
Slot in the M1.5 Allen Key and dock it at retracted position as shown above.
Thread the M1.5 Allen Key thru the 23.5mm Compression Spring then followed by the Terminal Block. Fully compress the spring and tighten both screws in Terminal Block as shown above.
Left: Auto Level Probe in deployed position. Probe tip must be lower than the Hot End nozzle tip. Right: Auto Level Probe in Retracted position. Probe tip must be higher than the Hot End nozzle tip.
When Auto Level Probe in Retracted position, Probe tip must be higher than the Hot End nozzle tip.
Stepper Motor Wires = 4 sets

[Prepare Parts]

Parts required for Tower Motors Wire Termination as shown above.
Insert the Stepper Motor Wires into Stepper Motor’s Socket as shown above.
Repeat Step \{D83\} for the remaining Stepper Motors as shown above.
Prepare Parts

Parts required for Print Bed Mount as shown above.

- 180mm Diameter Glass Bed = 1 pc
- M3x8mm Cap Screw = 3 pcs
- M3 Nut = 6 pcs
Apply Kapton Tape or any Heat Resistant Tape on the Glass Bed. Prepare 3 sets of Glass Bed Fastener using M3x8mm Cap Screws and M3 Nuts as shown above.
Slot in the Glass Bed Fastener into the OpenBeam rail guide as shown above.
Lay the Glass Bed on top of the Bottom Frame. Tighten all 3 fasteners once the Glass Bed is centered properly. Make sure Glass Bed is firmly secured before print.
Parts required for Auto Level Probe Retractor as shown above.

M3x20mm Cap Screw = 1 pc
M3 Nut = 2 pcs
Slot the Auto Level Probe Retractor into the rail guide at X-Z Edge.

Tighten the M3x20mm Cap Screw once in position as shown above.
Let’s Wire It Up
Controller Board andWirings
Prepare Parts

Parts required for Controller Board Assembly as shown above.

- Arduino Mega2560 = 1 pc
- RAMPS 1.4 = 1 pc
- Stepper Driver = 4 pcs
- Jumper = 12 pcs
Assemble

Fully slot in the RAMP1.4 board on top of the Arduino Mega2560 Controller Board as shown above.
Assemble

Slot in 3 pcs of Jumpers per Stepper Motor slot in RAMPS1.4 board as shown above. Total 12 pcs of Jumpers needed
Slot in 4 pcs of Stepper Driver to RAMPS1.4 board as shown above.
Assembled Controller Board = 1 set

M3x35mm Cap Screw = 2 pcs

M3 Nut = 4 pcs
Assemble

Thread M3x35mm Cap Screws thru the boards’ screw holes, then follow by M3 Nuts as shown above.
Attach the assembled Controller Board at X-Z Edge of Top Frame thru the OpenBeam slot guide opening, then tighten the 2 pcs of M3x35mm Cap Screws as shown above.
Terminate all the wires to the Controller Board as shown in the wiring diagram.
Let’s Power It Up

Power On and Connect to PC

Note: LCD Controller Board is for illustration purpose only. This Guide will use Computer Software & USB Connection to operate the Kossel Mini.
Detach the power terminal from Controller Board and measure the DC Power Supply as shown above. If terminated correctly, the voltage and polarity should be around +12V. **Wrong polarity will cause permanent damage to the Controller Board!!!**
Reconnect the power terminal to the Controller Board as per \{E08\} and switch on the power supply. Once the Controller Board is powered on properly, the LED Indicator should light up as shown.
Make sure FAN is operating ALL THE TIME when Controller Board is powered on. Also, verify that the FAN airflow is orientated correctly as shown in {D62}.!!! Continuous cooling is essential to prevent Hotend Jamming or Effector meltdown!!!
This Guide will use the following Software & Firmware Package for Kossel Mini.


For Mac User [http://www.blomker.com/KosselMini_Mac.zip]

Alternatively, you can check for any latest updates in the future and download them individually if needed:


Printrun-Pronterface [http://koti.kapsi.fi/~kliment/printrun]

Slic3r [http://slic3r.org/download]

jcrocholl Marlin [https://github.com/jcrocholl/Marlin]

Download the required Software and Firmware Package to the Computer and extract the .zip file
This Guide will use Software and Firmware setup as shown above to calibrate/fine-tune/operate the Kossel Mini and eventually, first test print.
Install Arduino Software in the Computer by executing the .exe file. Once completed, connect the Computer to Kossel Mini USB port. Verify the COM Port Number assigned for Arduino Mega 2560 (eg. COM34) as shown above.
Run file [Blomker KM File/Marlin_delta2/Marlin_delta2.ino]. Go to Tools->Board, select Arduino Mega 2560 as shown above. In case you have been following exactly our build instructions from Part {A} to {E}, this Marlin_delta2 Sketch will instantly enable your Kossel Mini for Part {G} verifications, and then followed by calibration and first test print.
Go to Tools->Serial Port, select the COM Port as per assigned in Step {F06}. 

[Select the COM Port]
Click the “Upload” button to upload the Marlin_delta2 Firmware Sketch to Kossel Mini Controller Board. Once upload successful, message “Done Uploading” will be displayed.
Locate and run file [pronterface.exe] extracted during {F04}. Set COM Port as per assigned in Step {F06}, and Baud Rate to 250000, then click “Connect”. Once connection successful, messages will be shown as above. Ignore message “SD init fail” as LCD Controller Board with SD Card not available.
Let's Check It Out

Verify Kossel Mini Setup using Pronterface

Note: Verifications needed to ensure Kossel Mini has no wiring or hardware issues. Verification result is based on the Marlin_delta2 firmware uploaded to Kossel Mini during {F10}. 
[Verify Endstops & Auto Level Probe Status]

[MCODE] M119

[Sample Output]

>>>M119
SENDING:M119
Reporting endstop status
x_max: open
y_max: open
z_min: TRIGGERED
z_max: open

[Observation: x_max, y_max, z_max]

Carriage in contact with Endstop Switch => “TRIGGERED”
Carriage NOT in contact with Endstop Switch => “open”

[Observation: z_min]

Auto Level Probe in contact with Switch (Deployed) => “open”
Auto Level Probe NOT in contact with Switch (Retracted) => “TRIGGERED”
[Verify Nozzle/XYZ Carriages Homing]

[GCODE] G28 or [GUI]

[Observation: Nozzle/XYZ Carriages Movements]
All XYZ Carriages will travel towards respective Endstops and slightly back off after in contact with respective Endstop switch.

[Important Note]
Nozzle/Carriage Homing also means to park the Nozzle tip at Cartesian Coordinate [0,0, MANUAL_Z_HOME_POS]. In this case, [0,0,239]

After Power Cycle or Reset, Controller Board will lost track of Nozzle’s Cartesian Coordinates/Carriages’ position. It is essential to send GCODE [G28] or using GUI “HOME” button to update again current Nozzle coordinates
[Verify Current Coordinates/Position]

[MCODE]  M114

[Sample Output]

SENDING:M114
X:0.00Y:0.00Z:239.00E:0.00 Count X: 425.52Y:425.52Z:425.52

[Observation: X:0.00Y:0.00Z:239]

Indicate the current Cartesian coordinates of Nozzle Tip when HOME. “Z:239” corresponds to “#define MANUAL_Z_HOME_POS 239” in [Configuration.h] of Marlin_delta2. This info will be referred during Calibration.

[Observation: Count X: 425.52Y:425.52Z:425.52]

Indicate the current linear position of Carriages on their respective Towers.

[Important Note]

If output is “X:0.00Y:0.00Z:0.00E:0.00 Count X: 0.00Y:0.00Z:0.00”, Controller Board have lost track of positions. Need to home all Axis again.
[Verify Extruder Motor Extrude and Reverse Motion]

[MCODE] M302 and [GUI]

[Observation: Extruder Motor Drive Gear Rotation]

After sending MCODE [M302], verify Extruder Motor Drive Gear Rotation as below:
Extrude => Clockwise Rotation
Reverse => Counter Clockwise Rotation

[Important Note]

“#define EXTRUDE_MINTEMP 170” will prevent Extruder Motor from any motions when Nozzle temperature is below 170C. Hence, MCODE [M302] needed to enable cold extrusion before this verification is possible.
[Verify Hotend Temperature]

Select 185 (PLA) and click “Set”. Verify that temperature is sustainable (at least 15mins) after reaching 185C. Then follow by similar verification for 230C. In case failed to attain target temperature after continuous heating:

1. Make sure the FAN airflow not directed to Hotend’s heat block {D62}
2. Make sure Heater and Thermistor wires terminated properly {E08}

[Important Note]

Before proceed for Hotend Temperature verification, ensure step {F03} already verified. At this stage, do not leave the Hotend unattended during Temperature verifications, especially when heating above 185C. Click “Off” to cancel heating of Hotend once Temperature verification completed.

[Observation: Hotend Target Temperature Sustainable]

Select 185 (PLA) and click “Set”. Verify that temperature is sustainable (at least 15mins) after reaching 185C. Then follow by similar verification for 230C. In case failed to attain target temperature after continuous heating:

1. Make sure the FAN airflow not directed to Hotend’s heat block {D62}
2. Make sure Heater and Thermistor wires terminated properly {E08}

[Observation: No Overheating at Effector]

Continuous cooling by the FAN airflow should keep the Effector (PLA material) below 100C.
Let’s Calibrate

Calibration and Fine-Tuning

Note: There will be no identical Kossel Mini units. The provided Marlin_delta2 Firmware contains calibrated settings for a working unit built by Blomker Industries. It will be more on fine tuning the values to match your built unit if you are using Marlin_delta2 Firmware.
To calibrate a Delta Printer like Kossel Mini, it is essential to distinguish XYZ Axes from XYZ Towers. In essence, Delta Printer makes coordinated movements of XYZ Carriages on their respective Towers, which will translate to movement of Nozzle (Print Head) in Cylindrical/Cartesian print space, consist of XYZ Axes and Coordinates.
Unit of XYZ Coordinates are in [mm].

Boundaries/Radius of the Cartesian print space are specified by Min & Max parameters of XYZ Axes in [Configuration.h] of Marlin_delta2 Firmware.

Two key Coordinates needed during Calibrations are the HOME Coordinate [0,0,Zmax] and Center of Bed [0,0,0].
Nozzle movements are controlled by means of sending GCODE G1 + XYZ Coordinates (in mm), or using GUI + Distance of Movement (in mm).

For GUI method, minus (-) sign meaning to move towards Min direction of the Axis. As for GCODE, it represents the negative coordinates (<0), which in this case, we will only have positive and negative X or Y coordinates. Z Axis will only have positive coordinates (>0)
If initial position of Nozzle is at HOME position, illustrations above demonstrate the difference between movement by GUI + Distance of Movement and GCODE + Coordinates. Good understanding and combo usage of both methods can help to shorten calibration time, especially during Z-Axis and Bed Auto Leveling Calibration.
Delta Kinematics is the algorithm in firmware which translates XY Coordinates in the Cartesian plane to the required linear positions of XYZ Carriages on respective Towers. The key dimensions below in [Configuration.h] are required by the Delta Kinematics for accurate representation of the Nozzle position in XY plane. Send GCODE G28 to home the XYZ Carriages before taking measurement from the as built unit.

// Center-to-center distance of the holes in the diagonal push rods.
#define DELTA_DIAGONAL_ROD 213.5 // mm (215) [1]

// Horizontal offset from middle of printer to smooth rod center.
#define DELTA_SMOOTH_ROD_OFFSET 136.5 // mm (137.0) [2]

// Horizontal offset of the universal joints on the end effector.
#define DELTA_EFFECTOR_OFFSET 20 // mm (19.9) [3]

// Horizontal offset of the universal joints on the carriages.
#define DELTA_CARRIAGE_OFFSET 12.0 // mm (19.5) [4]
Conversions from number of steps to distances travelled in mm are defined in [Configuration.h] as shown above.

For more info, kindly refer to the wonderful RepRap Calculator tool shared by Josef Prusa [http://calculator.josefprusa.cz]

Please note that Extruder Motor is using a different Drive Gear than XYZ Motors
Print Height/Print Bed Centre Calibration procedures using Pronterface are as below:

1. Send GCODE G28 to home the Nozzle
2. Send MCODE M114 to check Z Height at HOME position. Z:239 corresponds to MANUAL_Z_HOME_POS 239 in [Configuration.h]
3. Send GCODE G1 Z10 to move the Nozzle close to the Print Bed
4. Use GUI to move nozzle 1mm towards Print Bed
5. Repeat 4 till gap between Nozzle and Print Bed less than 1mm
6. Repeat 4 but move 0.1mm towards Print Bed
7. Repeat 6 till Nozzle is 0.1mm above Print Bed. This Nozzle position will be defined as Print Bed Centre [0,0,0]
8. Send GCODE M114 to check the current Z value.
9. New MANUAL_Z_HOME_POS value = Old MANUAL_Z_HOME_POS value – current Z value. This new value will defined the Max Print Height.
10. Update #define MANUAL_Z_HOME_POS __?__ with the new value. Then reupload the updated Marlin_delta2 firmware using step {F09}
11. If 7 is not possible, software Endstop limit reached. Update value in [Configuration.h] #define min_software_endstops false and repeat Step {F09}. Kindly disconnect Pronterface before attempting Step {F09}
12. Repeat 1 to 7. Once completed, then Repeat 11 with value true.
GCODE G29 consist a set of continuous procedures which eventually align Nozzle to move at uniform Z Height above a flat Print Bed.

After sending GCODE G29, 3 procedures as below will be automatically executed:

1. Deploy Z Probe
2. Probe Print Bed (at 37 Locations)
3. Retract Z Probe

Below is the snapshot of G29 main codes found in [Marlin_main.cpp]:

```c
// G29 Calibrate print surface with automatic Z probe.

saved_feedrate = feedrate;
saved_feedmultiply = feedmultiply;
feedmultiply = 100;

deploy_z_probe();
calibrate_print_surface(z_probe_offset[Z_AXIS] +
    (code_seen(axis_codes[Z_AXIS]) ? code_value() : 0.0));
retract_z_probe();

feedrate = saved_feedrate;
feedmultiply = saved_feedmultiply;
previous millis_cmd = millis();
endstops_hit_on_purpose();
break;
```
The default Z Probe deployment mechanism is by pushing the horizontal portion of Z Probe against the GT2 belt of Z-Tower. The XYZ coordinates shown below is where the pushing of Z Probe (in –X direction) against GT2 belt will begin from.

Our recommendation is to deploy the Z Probe manually by hand, then follow by sending GCODE G28 before sending GCODE G29. This will eliminate the need to extend the horizontal portion of the Z Probe (using extra materials), and also reduce the risk of accidental deployment of Z Probe during printing at certain locations.

Manual Z Probe deployment by hand will not affect the Probing and Retraction of Z Probe in later stage of GCODE G29 procedures.

In case the auto Z Probe deployment method is preferred, make sure the XYZ coordinates is suitable for your built and horizontal portion of Z Probe is extended.
By default, the deployed Z Probe will probe the Print Bed at 37 locations. The exact probe locations are determined by 2 parameters in [Configuration.h]:

```
#define AUTOLEVEL_GRID 26
```

This parameter indicates the Distance between autolevel Z probing points, and should be less than print surface radius/3.

In Marlin_delta2 firmware, value 26 is chosen due to:

1. Print Radius (Xmax, Xmin, Ymax, Ymin POS) defined is 85mm.

2. Considering that value higher than 26 might cause collision of Effector platform/Fan with X & Y Towers’ GT2 Belt during probing stage.
This parameter indicates Distance between Nozzle and the deployed Z Probe’s tip. By placing Z Probe Holder as per {D58}, the X-Offset value is always “0”. The X and Y Offset values will be used by firmware to direct the Z Probe tip (using GCODE G1) to the 37 probing locations. As for Z Offset, repeat fine-tuning needed to make sure Nozzle position at [0,0,0] is the same before and after GCODE G29 procedures.
The Z Probe retraction mechanism involves moving the Z Probe’s tip above the Retraction Cap Screw (installed in step \{D90\}), and then lifts the Z Probe to docking position in the Probe Holder by pushing the tip vertically against the stationary Cap Screw. The related parameters to be fine-tune according to your built are as below:

```c
void retract_z_probe() {
    feedrate = homing_feedrate[X_AXIS];
    destination[Z_AXIS] = current_position[Z_AXIS] + 20;
    prepare_move_raw();

    destination[X_AXIS] = -60.0;
    destination[Y_AXIS] = 63.5;
    destination[Z_AXIS] = 30;
    prepare_move_raw();

    // Move the nozzle below the print surface to push the probe up.
    feedrate = homing_feedrate[Z_AXIS]/10;
    destination[Z_AXIS] = current_position[Z_AXIS] - 19;
    prepare_move_raw();

    feedrate = homing_feedrate[Z_AXIS];
    destination[Z_AXIS] = current_position[Z_AXIS] + 29;
    prepare_move_raw();
    st_synchronize();
}
```

The X & Y Coordinates indicates the position to place the Z Probe’s Tip before retraction. Leave the Z Coordinate unchanged at 30.

Indicates the distance of downward vertical movements needed to lift the Z Probe. After Z Probe at docking position, Nozzle will be lifted to 40mm above Print Bed. If modification needed to match your built, ensure that their absolute value difference is +10. Eg. 29 - 19 = +10
G29 or Auto Bed Leveling Calibration procedures using Pronterface are as below:

1. Deploy Z Probe manually by hand. Send MCODE M119 to verify “Z_min: open”
2. Send GCODE G28 to nullify any position errors introduced by 1.
3. Send GCODE G29 to start the Auto Bed Leveling procedures.
4. Once completed probing at the Last Probing Point (shown in {H10}), Z Probe retraction procedure will begin by moving to coordinates specified in {H12}
5. In case Z Probe’s tip not position above the Retraction Cap Screw, quickly use your fingertip as a support to allow lifting of Z Probe to docking position.
6. Once G29 procedures completed (idling), redeploy the Z Probe manually by hand again.
7. Use Pronterface GUI to move the Z Probe’s tip right above the Cap Screw. Once in position, send MCODE 114 and record down the X & Y coordinates.
8. Use Pronterface GUI to move Z Probe vertically downward in 1mm steps till the Z Probe being lifted back into docking position. Send MCODE 114 and record down the Z coordinate.
9. If needed, updates X and Y coordinates in {H12} as per value obtained in 7.
10. If needed, updates value “19” to New Value1 using equation as follow
    \[\text{New Value1} = 30 - \text{Value obtained in 8}\]
11. If New Value1 updated in step 10, updates value “29” to New Value2 as follow:
   New Value2 = New Value1 + 10.
12. If values in 9 to 11 are updated in Marlin_delta2 firmware, reupload the firmware using step \{F10\}. Remember to disconnect Pronterface before \{F10\}.
13. Once upload is successful, Controller Board will be reset automatically and the Print Bed interpolation/offset data stored during last GCODE G29 procedures will be cleared.
14. Repeat 1 to 13 until Z Probe is retracted properly without user intervention.
15. Send MCODE M114 to verify that Z Coordinate is 40 (40mm above Print Bed).
16. Send GCODE G1 X0 Y0 to center the Nozzle.
17. Use GUI to move Nozzle gradually towards center of Print Bed [0,0,0], same as the Nozzle position determined during \{H06\} Step 7.
18. Send MCODE M114 to verify if Z value is zero (“0”). If yes, G29 Calibration completed.
19. If step 17 is not achievable, or Z Value obtained in step 18 greater than “0”, reduce the Z Value in [\#define Z_PROBE_OFFSET {0, 14, -6.7, 0}], eg, to -6.9, or vice versa, then follow by reupload of firmware as per step \{F10\}.
20. Repeat 1 to 19 till Nozzle position at [0,0,0] is the same before & after G29 procedures.
Once completed steps {H05} to {H14}, perform verifications as follow using Pronterface:

1. Move Nozzle to 0.4mm above centre of Print Bed $[0,0,0.4]$.
2. Move Nozzle to XY Plane Print Boundaries at Coordinates $[85,0,0.4]$.
3. Verify Nozzle is 85mm from centre of Print Bed.
4. In case Nozzle is less than 85mm from centre of Print Bed, decrease value of #define DELTA_DIAGONAL_ROD ______ shown in Step {H05}, or vice versa.
5. Reupload the updated Marlin_delta2 firmware as per procedure in {F10}.
6. Repeat 1 to 5 till XY Plane’s dimension is as per defined (85mm).
7. Repeat 1 to 5 again with other XY Plane Print Boundaries at Coordinates $[-85,0,0.4]$, $[0,85,0.4]$ and $[0,-85,0.4]$. In theory, if the unit is built with proper symmetry, they should be uniformly 85mm from the centre of Print Bed as well.
Let’s Slice and Print

STL File Processing using Slic3r Software and GCODE File for First Test Print
Locate and run file [slic3r.exe] extracted during {F04}. In case Blomker KM Default not loaded as shown above, go to File-> Load Config... and load the file [Blomker KM Default Slic3r.ini] available in the extracted folder [Blomker KM Files]. This Config File is only meant to enable first test print for your Kossel Mini. Further tweaking needed if you have other printing requirements.
Locate file [10mm Calibration Cube.STL] in the extracted folder [Blomker KM Files]. Load the .STL file simply by drag and drop to Slic3r Print Plater. Dimension and Size info of the object are as shown above. Generate .GCODE file for test print by clicking “Export G-code” button.
Prepare PLA Filament

Straighten the filament end and taper off portion of the filament tip. This is to ensure smoother entry of filament thru the Extruder, Bowden tube and into the Hotend during filament feeding.
Feed the PLA Filament all the way into Hotend, either by using Pronterface GUI method shown in {G04}, or by hand feeding as shown above.
There is around 60-65mm of distance from the Push Fit Connector to the inner tip of brass Nozzle. The PLA Filament must be fully inserted into the Hotend, with the tip of Filament in contact with the
Deploy Z Probe by Hand as recommended in {H09}. Preheat Hotend to 215C as per similar procedure in {G05}. Allow molten PLA filament to drain from Nozzle before begin test print.
Once molten filament draining stops and Hotend able to sustain Temperature around 215C, loads .GCODE file generated in {I02} for test print. To start the test print, click “Print”. The G28 and G29 procedures are included in the .GCODE file during .GCODE generation using Blomker KM Default Slic3r settings.
10mm Calibration Cube printing in progress
In case dimensions of printed Calibration Cube are not accurate, refer to \{H15\} for dimension fine tuning procedures. In case fine-tuning of Steps per mm needed, it is recommended to recalibrate again from \{H05\} to \{H15\}.